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FAXmaker - an overview


Introduction


Congratulations with purchasing FAXmaker. FAXmaker for Intranet will save your company time and money by offering you advanced network fax technology. With FAXmaker, sending a fax is as easy as printing a document. 


FAXmaker for Intranet is designed to integrate seamlessly with any SMTP/POP3 based mail server. Therefore this manual assumes a working knowledge of SMTP/POP3 and TCP/IP, and that you have an SMTP/POP3 server up and running.





Requirements


FAXmaker for Intranet requires the following;


A standard SMTP/POP3 based mail server.


A Windows NT or 95 machine with at least 16 MB memory and a 100 Mhz 486. The machine does not need to be dedicated to FAXmaker. You can run the FAXmaker server alongside the mail server on the same Windows 95 or NT machine. FAXmaker requires very little resources or processing time.


Email client software capable of handling “aliases”. To send a fax conveniently, the user will need to store the fax number as an alias. This is explained in more detail later on, however most standard email software including Eudora lite, Eudora Pro, Netscape, Microsoft Internet mail and Microsoft Exchange.


One or more class 2 compatible fax modems, preferably quality modems. FAXmaker uses standard CLASS 2 fax modems. Although technically speaking you can use any class 2 modem, the reliability (how long you can leave the modem unattended), connect rate (average bps speed at which your faxes will be sent) and connect success percentage (The amount of fax machines the fax modem will not connect to) will depend almost entirely on the quality of modem you use. We recommend using a quality fax modem such as Zyxel or Multitech. They may cost a little more, but they are well worth the extra money.


( Why class 2 and not class 1? Class 2 is actually a more advanced protocol, which offloads a lot of the processing time to the modem. This allows your fax server to use less processor time and to be less sensitive to machine load.


( If you are using a US Robotics modem. Although FAXmaker includes a driver for US Robotics, GFI FAX & VOICE do not recommend the use of US Robotics modems. The fax part of the modem is not as good in terms of connect rate, connect success rate and reliability as other modems. 


The FAXmaker system


The FAXmaker installation consists of a Fax server program running as a gateway, and the client software, running on the users’ workstations. The client software consists only of a fax printer driver and a viewer, which enables all Email users to send a fax by printing to the FAXmaker driver. Using the viewer, users can view or print incoming faxes.





The system is depicted in the following figure;


� EMBED Visio.Drawing.3  ���


Figure 1 FAXmaker fax gateway� XE "fax gateway" � running on the mail server.


Figure 1 shows the FAXmaker fax server/gateway running on the mail server machine. If the mail server is running on Windows NT, there is no need to use a separate machine for the fax server. However, FAXmaker is compatible with any SMTP/POP3 server, so if your server is running on a UNIX system, FAXmaker can still be used, but needs to be installed on a separate Windows NT/95 machine.


How does FAXmaker for Intranet work?





FAXmaker acts as a fax gateway to all users on the network. By setting up a “fax mailbox”, FAXmaker can communicate with all email users via this fax mailbox. The fax mailbox is nothing else than a standard mailbox/POP account dedicated to the fax server. To send faxes, users direct their email to the fax mailbox. Likewise, the fax server routes inbound faxes or feedback to the email users, using the fax mailbox.





� EMBED Visio.Drawing.3  ���


Figure 2 How the fax mailbox interacts with the users


User 1, 2 and 3 can send faxes by sending a fax to the fax mailbox. An incoming fax will be sent to the appropriate user via the fax mailbox.


As depicted above, users send a fax by sending email to the fax mailbox. FAXmaker will regularly check the fax mailbox, convert any pending jobs to fax and send them out. 


How do users indicate to which fax number to send the fax?





There are two ways to configure “Fax addressing”.


1. Using the alias/name field of an email address. An internet email address, can consist of a name, followed by the email address of the fax mailbox, i.e.


661072 <fax@domain.com> - this will send a fax to 661072


 This method of addressing is the easiest to setup and requires no configuration changes on the mail server. Most internet mail software ( including Netscape 2.0, Eudora Lite&Pro) support this feature including the Exchange/Windows Messaging client of Windows 95 and Microsoft Internet mail. 


2. Using the first part of the email address as the fax number, i.e.


661072@domain.com - this will also send a fax to 661072


This method of addressing requires that the mail server can support what is called wildcard aliases, or the automatic routing of mails with an invalid email address to a certain mailbox. Rather than returning and error to the user, the mail server must forward the mail to the fax mailbox.


Preparing for the installation of FAXmaker for Intranet


Before continuing installation of FAXmaker for Intranet, ensure that you have understood how it works and that the requirements are met. Furthermore, you will need to create an account/mailbox, which the fax server will use.


You are advised to call the mailbox ‘Fax’. This makes the function of that particular mailbox clear to the users.








�
Installation


Introduction


This chapter describes the installation of the FAXmaker software onto the fax server. It will help you choose the installation options available, but will not discuss the user’s configuration options, which are explained in the following chapter.


Prior to running the installation procedure, you are advised to read the chapter “FAXmaker - an overview”.


Running the installation procedure


1. Insert disk 1 of the FAXmaker for Intranet disk set in your diskette drive. Remember that you must run the installation program from the computer with the fax modem(s) attached.


2. Run 'setup.exe' from the File Manager/Explorer or choose 'Run' from the 'File' menu in Program Manager and type in <a:\setup.exe>.


3. The set-up procedure will now start, and you will be prompted by the installation routine which language you wish to use. Select the right language and click 'Next' to continue.


4. Setup will now reqeust you to to close any open programs. When you have done so, click ‘Next’ to continue.


�


User information


5. Setup will now prompt you for your company name, fax number and registration number. The registration number is located on the disk envelope. If you are evaluating the product, do not enter a registration number. FAXmaker will allow you to setup a maximum of 2 users.


6. Setup will now ask you where you want the FAXmaker fax server files to be installed. FAXmaker will need approx. 10 megabytes of free hard disc space.� XE "disc space" � In addition to this you must reserve approximately 30 Mbytes for temporary fax files. Click ‘Next’ to continue.


7. Setup will now prompt you where to copy the client setup programs. The client setup programs must be run by the users from their PC. The setup program installs the fax printer driver and fax viewer on the user’s PC. Since the users must run the installation, it is best to choose a location which is accessible to all users. Click ‘Next’ to continue.


8. Setup will noe prompt you for a mail server name, scan time in seconds (interval that the FAXmaker intranet MTA checks the mailbox for outgoing faxes). Additionally setup needs to know the fax-mailbox name and password that you have created for the FAXmaker intranet MTA. 


�


Setup prompts for Mail server  name


9. The setup program will now copy all program files to the selected destination.


10.  - Windows NT users only - FAXmaker setup will now prompt you for a FAX service name. There is no need to change the service  name, however in certain cases in which you are re-installing FAXmaker, you might need to change the name in order not to conflict with the previous FAXmaker service names. Click ‘Next’ to continue.


Note: To de-install a service, you must delete all references to it from the registry and re-boot. Click OK to continue.


�


Setup prompts for a fax server service name


11. - Windows NT users only - FAXmaker setup will now prompt you for a service name for the Intranet MTA (Message transfer agent). There is no need to change the service  name, however in certain cases in which you are re-installing FAXmaker, you might need to change the name in order not to conflict with the previous FAXmaker service names. Click ‘Next’ to continue.


Note: To de-install a service, you must delete all references to it from the registry and re-boot. Click OK to continue.


12. - Windows NT users only - Setup will remind you that after rebooting your PC, you need to install the FAXmaker printer driver as described in the readme or in the Chapter ‘installing the client software’.


13. Setup will now finish the installation by creating a FAXmaker program group. This program group includes a number of applets which you need to run to complete the installation of FAXmaker for Intranet.


14. Setup is now ready copying the files and modifying the registry. To complete the installation and start the operation of FAXmaker for Intranet, you must follow the steps outlined in the dialog.


Steps to complete installation


Step 1: Reboot your PC


Reboot your PC. This is necessary for the printer driver to be installed.


Step 2: Install the FAXmaker Printer driver


If you are running Windows NT 3.51 or 4.0, you need to install the printer driver as described in the readme or in the Chapter ‘Installing the client software’ of this manual.


Step 3: Configure the FAX server


Configure the fax server. You need to setup at least one port (modem or fax board) to start the fax server. This is done using the Fax server configuration applet, located in the FAXmaker program group. The first time you start it, it will scan your PC for installed modems. You must have at least one class 2 modem installed. You can cancel the autodetect process at any time by clicking Cancel. After FAXmaker detects a class 2 modem, it will automatically configure the port for you with default settings. Accept these for now and close the Fax server configuration applet. For more information on the fax server configuration applet, check the Chapter ‘Fax server’ in this manual.


Step 4: Create user accounts


The fourth step is to create a number of user accounts that will be allowed to send and receive faxes. This is done in the user configuration applet located in the FAXmaker program group. To add users, clock ‘Add’, and enter their name and email address. FAXmaker will automatically create a user account with default settings. A dialog with the user name and the default settings will appear. Click OK to confirm creation of the user account. After creating a few accounts, click ‘Close’ to close the applet. For more information on the applet and the possible user settings, please check the chapter ‘User settings’.


Step 5: Start the FAXmaker Intranet MTA


You can now start the FAXmaker Intranet MTA (Message Transfer Agent). This program will check the fax maibox for outgoing and incoming faxes messages and distribute them to the fax server or to the users respectively. You can start this program from the FAXmaker program group. If you have Windows NT, you can also start this program as a service from the services applet in the control panel.


( If you want to run the FAXmaker Intranet MTA as a service, you must enter an account that has rights to log on as a service. This is done by highlighting the FAXmaker Intranet MTA service and clicking ‘Startup’.


�


The Windows NT services applet


�


The ‘Startup’ dialog of the FAXmaker Fax service.


( To run the FAXmaker Intranet  MTA or FAXmaker Fax service as a service, you need to enter an account name that has ‘Log on as service rights’. To have the FAXmaker Fax service and FAXmaker Intranet MTA start up automatically, change the Startup type setting to ‘Automatic’


Step 6: Start the FAX server program


Start the FAXmaker fax server. This program handles the sending and receiving of faxes on 1 or more ports. You can  start this program from the FAXmaker program group. If you have Windows NT, you can also start this program as a service from the services applet I the control panel.


You can monitor the fax server using the FAXmaker monitor, which displays port activity and modem status.


( If you want to run the FAXmaker Fax server as a service, you must enter an account that has rights to log on as a service. This is done by highlighting the FAXmaker Fax server service and clicking ‘Startup’.


� XE "OCR routing" �Installation of the OCR routing module





THIS SECTION IS ONLY APPLICABLE TO FAXMAKER USERS WHO HAVE PURCHASED THE OCR MODULE.


FAXmaker users can opt to purchase an OCR module, that can automatically route� XE "Route" � incoming faxes to the right recipient. With this module, the fax server will scan the incoming fax for a recipient name, and if it finds a recipient's name, FAXmaker will automatically route that fax to the recipient's mailbox.� XE "Mailbox" �


The module includes 1 OCR support disk, as well as a revised serial number. 


To install the module, run a:\setup.exe from the file run command in the Program manager menu. 


Follow the instructions explained during the installation. 


You will now be able to setup OCR routing per user from the User setup utility,� XE "administrator" � by going to the “OCR tab” in the routing setup.





�
User Settings


Introduction


All Email users who wish to be able to send and receive faxes must be added in the user configuration utility. 


The user configuration is done from the user configuration utility which can be started from the FAXmaker program group.


�


User setup utility


User settings


To add users and configure their settings;


1. Click ‘Add user’ You will be asked to enter the user name aswell as his/her email account.


�


Adding a user account


2. Click ‘OK’. The user will be created, and the user settings dialog will appear automatically.


�


The user settings


General Options


Remote administration - This option will allow the user to change coverpage, faxheader and send resolution by sending mail to the faxadmin (See the chapter on Remote administration for more information).


Send Options


Normal resolution/High resolution - Select the default resolution to send faxes in. This option can be overridden by specifying a different resolution in the body of the message. (See fax options� XE "FAX options" � in the “Sending faxes” chapter).


Personal FAX header� XE "FAX header" � - activating this option will include the sender’s name on top of the FAX. This will allow recipients of the FAX to identify the sender. 


Receive Options


Include fax files with notification - When a fax is transmitted, a user can choose to receive the converted fax file for backup/confirmation purposes.


Receive incoming faxes - This option specifies that this user must receive incoming faxes, so that she/he can route� XE "Route" \r "D2HBRoute11" � faxes to the right users.


Include/Exclude routed faxes - This option allows you to specify whether to include or exclude faxes  for which a recipient already has been found using available routing methods.


Routing


FAXmaker can automatically route an incoming fax to the right person. There are a number of ways through which this can be achieved; CSID routing, DTMF/DID routing and OCR routing.


�


Routing options available for each user


CSID routing - this method relies on the FAX ID� XE "Fax ID" � which each FAX machine/FAX card displays when sending a FAX. Since it rarely changes, it can be used to identify the sender and thus the corresponding recipient. 


�


Routing a fax using the FAX ID (CSID)


You can setup CSID routing by adding CSID’s (FAX ID’s) to a user’s CSID list. FAXmaker will then route incoming faxes with that particular CSID to that user.


Automatic Updating of the user’s CSID list.


Enabling the option ‘Store CSID’s of all outgoing faxes in list’ will automaitcally update the user’s CSID list.


The CSID of each recipient of a fax a user sends will be stored in the CSID list. This technique relies on the fact that if a user sends a fax to a particular fax machine, he is likely to be the recipient of the answer to the fax. If you enable this option, each time the user sends a fax, the CSID of the receiving fax is stored in the user’s CSID database.


DTMF routing - DTMF (Dual Tone Multi Frequency) tones are the tones generated by a telephone handset, and can be used to identify a recipient. The DTMF number can be appended after the regular fax number. The system works in the following way; The caller dials the fax number and waits until the call is answered. The fax card will now transmit a tone, after which the caller must enter the DTMF routing number. The FAXmaker server will recognise the DTMF number and use it to identify the recipient of the fax.


DTMF routing can work well, if you explain your callers how to use it. This can be done on the FAX coverpage of outgoing faxes. DTMF routing can also be used behind a PBX which supports DID. In this case you can use excess DID lines from the PBX to route the FAX to an extension.


�


Routing a fax using DTMF/DID routing


DID routing (Direct Inward Dial) - DID routing is generally considered the most reliable form of automatic inbound� XE "Inbound" �� XE "Inbound router dialog" � routing, because it relies on information provided by the telephone exchange, not on information provided by the caller. The system is completely transparent to the caller and does not require any effort on his part. DID can be used in conjunction with a PBX or hardware that recognises DID signals. 


To setup both DID and DTMF routing, go the DID/DTMF� XE "DID/DTMF" � tab in the routing dialog. Fill in an appropriate routing code for the user. Remember that actual activation of DID or DTMF routing is done in the FAX server. The administrator� XE "administrator" � only stores the users’ routing code. The same routing  code can be used for both DID or DTMF routing.


�


The OCR routing properties dialog


OCR routing - OPTIONAL MODULE - Another easy way to route faxes automatically is using OCR. This system will OCR the first page of a fax, and consequently search the fax for a recipient name. If it finds one, it will route it to the recipients mailbox.� XE "Mailbox" � This option requires the optional OCR module.


�


Routing a fax using OCR


OCR routing requires the purchase of an additional module, the OCR engine. If you have not purchased the OCR module, you can configure it, but not activate it.


To setup OCR routing, click the OCR setup button in the Routing tab. This dialog has two tabs ;


1.  Greeting - meaning that the FAX server will search for a greeting such as Dear, Mr etc., before the actual user name. This means that the FAX server will only attempt to recognise a user name after it has recognised a  greeting word. You can add and remove greetings by clicking the add and remove buttons. You can enter a matching ratio, or confidence level in the edit box. This allows you to specify the confidence FAXmaker must have before it will actually recognise it as a greeting. Using this option you can tune the system to your specific needs. For normal use, a low setting is required, since greetings are short, and a lower matching ratio allows for OCR mistakes, and for 'spelling mistakes'.


2.  User keywords� XE "keywords" � - here you can enter keywords per user, which FAXmaker will search for to identify the recipient of a FAX. If, for example, an individual Mr. Johnson, is also known as John, this keyword may be entered also, as well as Mr. Johnson. In addition, if Mr. Johnson is responsible for international sales, one might add international sales as a keyword too. A matching ratio can be entered to tune the system. 


Call blocking


�


Call blocking properties


Call blocking allows you to exercise control over the fax numbers that the users can send to. To enable this option, activate the ‘Disallow numbers to dial out’ radio box at the bottom of the dialog. You can now add numbers to the list which may not be dialled by the user. FAXmaker will check the list before each fax transmission, and not send any faxes starting with numbers listed in the call blocking list. This means that if you want to disallow certain users making international fax transmissions, you only need to insert the international dial out number (for example 00, 09 or 011). Alternatively you can block specific fax-numbers. 


User info


�


The user info properties.


This tab allows you to enter additional information regarding the user. This information is used for filling in coverpage/templates with the sender’s information.


The fields in the dialog correspond with the following coverpage/template fields.





User properties�
Merge field�
�
Company�
<S_Company>�
�
Department�
<S_Department>�
�
Fax�
<S_PH_Fax>�
�
Voice�
<S_Phone>�
�
Coverpages & Templates


Each user can store a number of coverpages and templates to be used for sending faxes.


�


The Coverpage and Template properties dialog


Difference between a coverpage and a template


A coverpage is inserted in front of each fax, and a template is used to format text from an email message onto a template. This means that by designing a template with a letter head and fields, you could eliminate the use of a coverpage.


Whether you use a template or coverpage or both is up to you to decide.


Each user can have multiple coverpages & templates, of which one can be set as default. To override the default cover or template for a particular fax, the name of the coverpage or template must be specified in the body of the email message, as follows;


::C=cover1, T=template


For more information about specifying fax options,� XE "FAX options" � see the fax options section in the “Sending faxes” chapter.


Adding templates or coverpages


FAXmaker ships with a number of sample templates and coverpages. By default, FAXmaker will use the file template.rtf (located in the faxmaker-coverpge subdirectory) as a template for all users.


By modifying template.rtf you can avoid configuring a template file for each user. 


To add a custom coverpage or template;


1. Design your coverpage/template in your wordprocessor and save it as an RTF (Rich Text format) file. For more information on designing a coverpage/template, check the chapter ‘Coverpages & Templates’.


2. Click ‘Add’ and select the RTF file you created.


3. If you wish to set this RTF file as the default, click ‘Set Default’.


Mail server settings


The user setup utility also contains a dialog which allows you to change the mail server settings which you entered during installation. Here you can enter the mail server name, the poll time ( i.e how frequently the fax server must check the fax mailbox) and the email account and password of the fax server.





�
The Fax Server


Introduction


The Fax Server program is the core of FAXmaker. It is fully multitasking and will handle sending and receiving of faxes simultaneously. The Fax Server can run as an application or as a service. Setup of the Fax server is performed from the FAXmaker Fax server configuration applet.


�


The fax server configuration� XE "Server configuration" � applet


Registration


Before you setup the fax server, enter your serial number in the register dialog. This serial number will also allow you to upgrade to more users or add additional modules. To read more about the upgrade options of FAXmaker, please visit our web site at http://www.gfifax.com.


To enter the serial number;


1. Click on ‘Register ‘.


2. Enter your company name & registration number Click OK to continue.


Note; If you are evaluating FAXmaker for Intranet, leave this field empty and test FAXmaker with 2 Users users maximum.


Note; Please take some time to register your product using our WWW form on our site;


http://www.gfifax.com/pages/regfrm.htm


This will allow you to request support.


Configuring the Fax Server


Before you start the Fax Server, you must configure the 'Ports' that you will be using in the Fax server. A port� XE "port" \r "D2HBport17" � is a COM port with a modem attached or a fax line on a fax/ISDN board. To configure a port;


1.  Start up the Fax server configuration applet.


The first time you start it, it will automatically scan your PC for an available port. You cancel this process by clicking cancel.


�


FAXmaker detecting a fax device


( If you have cancelled the scanning of ports earlier, or have an installed an additional modem or board, you can select ‘Add’ to create an extra port. You will be able to choose from a list of fax devices.


2. You can specify the port settings by double-clicking on a port or selecting a port and clicking ‘Properties’.


3. A tabbed dialog will appear, which allows you to specify modem, fax, printing, routing and archive options for that port. If you have OCR installed an OCR tab will also appear.


�


The modem properties  tab


Modem Properties


This tab allows you to configure your modem. 


Modem control


Modem type - Select your modem from the drop down list box.


Initialisation string - Although the initialisation string does usually not need to be changed, you can edit the string in this field.


Line options


Tone dialling - Activate this check box if you can use tone dialling. If you deactivate it, the Fax server will use pulse dialling. 


Wait for dial tone - If you activate this option, the fax server will only send the fax if the modem detects a dial tone. Some export� XE "Export" � modems do not recognise the dial tone, so you must first test whether your modem recognises a dial tone.


Check for busy tone - Activate this option if you want the modem to check for a busy tone.


Speaker mode - Select whether you want the speaker to be 'Always Off', or 'On until connected' or 'Always On'.


Speaker volume - Select the appropriate volume. 


�


The fax setup tab


Fax Setup


General options


Maximum Speed - Select the send & receive speed according to your modem's capabilities. Remember that not all modems are able to negotiate “down” well, so choose 9600 if in doubt.


Local ID- Enter the fax ID� XE "Fax ID" � which you wish to appear above each fax.


Send options


Send outgoing faxes - This radio box allows you to determine whether this port/modem should send faxes.


Dial prefix - If your lines are located behind a PBX, you can specify a dial prefix here.


Number of retries - Sets the number of times FAXmaker will try to send a fax.


Retry delay - This option allows you to set a delay between retries in seconds.


Fax header� XE "FAX header" � - The fax header is a word or company name which will appear on top of each fax.


Receive options: 


Answer incoming calls - For the fax server to be able to receive faxes, this option must be checked. Specify after how many rings you want FAXmaker to answer in the 'Rings until answer field'.


Attach OCR document - If you have the OCR module installed, you can select to have the OCR text output attached to the incoming fax.


Incoming call detection� XE "Incoming call detection" � - By default the fax server will answer all incoming calls as fax only. However, if you have installed the voice mail� XE "voice mail" � or fax on demand� XE "fax on demand" � module (optional module), you can have the fax server detect between fax/voice or voice only calls. 


�


The routing setup tab


Routing


Inbound� XE "Inbound" �� XE "Inbound router dialog" � routing of faxes is set up in the Administrator,� XE "administrator" � however you must activate the various routing methods in the server in the routing properties tab. Activate a routing method by clicking on the appropriate radio box.


( Do not enable DTMF routing unless you have a compatible voice modem correctly setup. Compatible voice modems are Zyxel or modems that have a Rockwell voice chipset. You must also select the corresponding driver in Modem properties as either Voice modem (Rockwell) or Zyxel. If you enable DTMF routing without having a voice modem, the fax server will generate an error whilst receiving.


DTMF options


Generate beep - you can have the Fax server generate a beep when it picks up the line. This will alert the caller or PBX to enter the DTMF string.


Number of digits - Length of DTMF string/number that caller or PBX must generate.


�


Autoprint properties


Autoprint


The printing options dialog allows you to configure automatic printing per port.� XE "port" \r "D2HBport21" � That is, you can select either the same or different printers to service the printing requests from various ports. Both incoming and outgoing faxes can be printed automatically. Printing of outgoing faxes is configured in the general setup because it is not port specific.


( Because a fax is an image, printing a fax can take some time. The auto-print feature requires a faster PC, and printing must be set to low priority in the print manager if the printer is connected to the fax server directly.


�


Archiving properties


Archive


This tab allows you to specify the archive options. Archiving allows you to create a backup of all incoming and outgoing faxes.


If you have the OCR module installed, FAXmaker will store the OCR text output in the same directory, using the same file name as the corresponding fax file, but using extension *.txt instead of *.fax.


Archive incoming - Archives all incoming faxes in a directory of your choice.


Archive outgoing - Archives all outgoing faxes in a directory of your choice.


RTF converter setup


The RTF converter converts E-Mail messages to fax, using a customisable RTF file as a template. The converter options are changed from the FAX server configuration� XE "Server configuration" � applet. 


�


RTF converter setup


To change RTF conversion options;


1. Click the RTF setup button at the bottom of the list of ports.


2. A dialog appears which allows you to specify the margins which you wish to use. It is important to take these margins into account when designing your cover page.


3. The default page size cannot be changed. The list box has been included to indicate that you must set the page size of your RTF template to 81/2 by 11 inches. (Standard US size) This will in no way effect your fax transmissions.  � XE "cover page" �


General options


The general setup contains general options which are not specific to a port. To change general options;


1. Click the general button at the bottom of the list of ports.


2.  A dialog appears which allows you to specify general options;


�


The general options dialog


Autoprint


Autoprint outgoing faxes  - This option automatically prints all faxes that are sent successfully. You can select a printer to which to automatically print from the list box.


Print report if successful - FAXmaker can print a transmission report after succesfully sending a fax. In addition a minitiature of up to 4 pages of the fax can be included on the report.


Scan directory for text files


 This option allows you to send faxes programmatically, by posting a correctly formatted text file in the ‘scan directory’. In this way you can integrate FAXmaker with a Web server, and allow a custom CGI script to send a fax automatically.


To send out a text file automatically;


1. Create a text file with your message text in it.


2. Add a line, starting with a double colon (::), specifying the fax number and optionally the recipients name and company (for use in the cover page). For example:


::Mr Johnson, GFI, 661072


3. You can add additional send options by adding a second line, preceded by a double colon, specifying valid send options as described in the ‘Sending Faxes’ chapter.


If the fax is transmitted succesfully the extension of the fax file name will be changed to *.suc. If the fax has failed, the extension will be changed to *.err. This allows you to give feedback to the user of your program.


Text files are formatted using an rtf file as a template. This way you can add your company logo etc. to the text file. The rtf file is called txttmpl.rtf and is located in the coverpage directory.


� XE "Monitor" �The FAX Server Monitor


The Fax server monitor allows you to monitor the status of the fax server. The top pane shows the activity on each of the ports, and the bottom pane shows you a detailed error log.


�


The Fax server monitor


The Fax server monitor can be started from another PC as well, however the error log will not be listed.


Aborting a fax


To abort a fax select the appropriate port and select ‘Abort’ from the port menu.


Running the fax server


The FAXmaker fax server can be run as an application from the FAXmaker program group or as a service from the services applet.


The FAXmaker fax server can also be run from the console/command prompt by specifying -desktop. For example;


fgwmserv -desktop.


This will start the FAXmaker fax server as an application and allow you to quickly start and stop the fax server.





�
Installing the Client software


Introduction 


After installing the fax,  you can already send faxes by typing the message in the Email program. However if you wish to send faxes directly from your Windows applications, or wish to view your incoming faxes using the FAXmaker viewer, users must run a setup program from the user’s machine first.


The setup program installs the printer driver and the viewer on the user’s machine.


Installing Windows 3.1 or 3.11 clients


1.  Run <setup.exe> located in the install\win 3.1 directory located under the install directory, by using the 'Run' command from the 'File' menu in Program Manager. The exact location of the client setup programs was determined during initial FAXmaker setup.


2.  Follow the installation instructions displayed in the installation dialogs. Setup will copy a number of files to the directory faxmaker, located under your windowsdirectory.


3. Setup will prompt you to ask you how it should start up your email application. FAXmaker needs to know this in order to startup your application automatically after printing to fax. To startup your e-mail application, FAXmaker can use one of two methods;


a. MAPI (Simple MAPI) - MAPI is a standard promoted by Microsoft, and supported by many applications including MS Exchange, Eudora PRO, CC:Mail and others. Using this option FAXmaker will start up your email application with your fax file as an attachment to a new message.


b. Command line - FAXmaker can start up your email application by running the executable and specifying the fax attachment on the command line. This option is compatible with Eudora PRO 3.0.


Consult your administrator if you are not sure which option to use.


4. Reboot your machine after completing the installation.


Installing Windows 95 clients


1.  Run <setup.exe> located in install\win95 directory by using the 'Run' command from the 'File' menu in Program Manager.


2.  Follow the installation instructions displayed in the installation dialogs. Setup will copy a number of files to the directory faxmaker, located under your windowsdirectory.


3. Setup will prompt you to ask you how it should start up your email application. FAXmaker needs to know this in order to startup your application automatically after printing to fax. To startup your e-mail application, FAXmaker can use one of two methods;


a. MAPI (Simple MAPI) - MAPI is a standard promoted by Microsoft, and supported by many applications including MS Exchange, Eudora PRO, CC:Mail and others. Using this option FAXmaker will start up your email application with your fax file as an attachment to a new message.


b. Command line - FAXmaker can start up your email application by running the executable and specifying the fax attachment on the command line. This option is compatible with Eudora PRO 3.0.


Consult your administrator if you are not sure which option to use.


4. Reboot your machine after completing the installation.


� XE "Windows NT" \r "D2HBWindows_NT23" �Installing Windows NT3.51/4.0 clients


1.  Run <setup.exe> located in the \install\winNT35 or 40 directory by using the 'Run' command from the 'File' menu in Program Manager.


2.  Follow the installation instructions displayed in the installation dialogs. Setup will copy a number of files to the directory faxmaker, located under your windowsdirectory.


3. Setup will prompt you to ask you how it should start up your email application. FAXmaker needs to know this in order to startup your application automatically after printing to fax. To startup your e-mail application, FAXmaker can use one of two methods;


a. MAPI (Simple MAPI) - MAPI is a standard promoted by Microsoft, and supported by many applications including MS Exchange, Eudora PRO, CC:Mail and others. Using this option FAXmaker will start up your email application with your fax file as an attachment to a new message.


b. Command line - FAXmaker can start up your email application by running the executable and specifying the fax attachment on the command line. This option is compatible with Eudora PRO 3.0.


Consult your administrator if you are not sure which option to use.


4. Reboot your machine after completing the installation.


Installing the Windows NT 3.51 fax printer driver.





After running the FAXmaker Windows NT Install program, you must install the fax printer driver from the Print Manager. 


To create a printer, you must be logged on as a member of the Administrators, Server Operators, Print Operators, or Power Users group. 


1. Start the Print Manager from the Control Panel or Main group.


2. From the Printer menu, choose ‘Create Printer’.


3. In the Printer Name box, type <FAXmaker>.


�


The Windows NT create  printer dialog


4. Install the FAXmaker printer driver; In the Printer Properties dialog box, select ‘Other’ in the Driver box. 


5. In the Install Driver dialog box, specify the drive and path where the install\winnt directory is located, for example;


d:\apps\install\winnt35 and choose the OK button. 


6. In the Select Driver dialog box, select the FAXmaker driver. Then choose the OK button. 


7. The driver will now be installed by FAXmaker. 


8. In the Driver box, select the FAXmaker printer driver ‘FAXmaker’. 


9. In the Print To box, Select the ‘GFIFAX’. (This port� XE "port" � should have been automatically added after you rebooted the system. 


10. In the Create Printer� XE "Create Printer" � dialog box, choose the OK button. 


11. This completes a basic printer installation. Once a driver is installed, Print Manager automatically displays a dialog box allowing you to set up the features of your printer. There is no need to change any of these options. 


12. Remember that under NT the client must be active before printing to the FAXmaker printer driver. Otherwise the send fax windows will not pop-up automatically.


Installing the Windows NT 4 fax printer driver.





After running the FAXmaker Windows NT Install program, you must install the fax printer driver from the Print Manager. 


To create a printer, you must be logged on as a member of the Administrators, Server Operators, Print Operators, or Power Users group. 


Go to the Add printer wizard located in the printers folder in the control panel.


P.S. You may need your Windows NT 4 install disks at hand.


1. Start Add Printer


2. Select 'My Computer'


3. Select Next


4. Select GFIFAX: from available ports list. This port will only appear after running the client installation and rebooting your machine after installation.


5. Select Next.


6. The printer selection dialog will appear. Select 'Have Disk'


7. Enter the path to the FAXmaker NT driver directory; namely \faxmaker\client\program\winnt4.


8. Choose O.K.


9. Verify FAXmaker printer driver appears in Printer dialog.


10. Choose Next.


11. The Add Printer wizard will prompt you to insert the Windows NT 4 CD ROM. However, if you    have an English installation, you can simply delete i386 from the path that is prompted and    use the files supplied by the FAXmaker install.


Click OK to continue.


12. You may choose to use FAXmaker as you default printer driver.


13. Choose Next.


14. Choose not shared.


15. Choose Next.


16. Do not print a test page.


17. Choose finish.


Remember that for the Email client to automatically pop up after printing to the FAXmaker printer driver, the FAXmaker icon must be loaded before.


�
Advanced Use


Introduction


The chapter on advanced use is meant for users of FAXmaker who wish to tune their FAXmaker installation and get to know all its features.


Fax server error messages


2000: Error 2000 means: look in Windows NT Event Log for a description. You can also


see the description in the FAXmaker Monitor application.


RTF2FAX Errors


1600  Open File Failed


1601  File not found


1602  Read file failed


1603  Coversion failed


1604  Fax recovery/conversion failed


1605  Already initialised (should never happen!)


1606  Initialisation failed


1607  Coverpage does not exist


1608  The specified Rich text file is not valid


1609  An Unknown error occured


FAX Service errors


2000  Unable to start the FAX Service. Complete description of the error is given in the Event-Log 


-1000L  // driver module not found


-1001L  // driver does not support required functions


-1002L  // invalid line ID


-1003L  // no Windows timer available


-1004L  // function not supported by the driver


-1005L  // another task still active on the line


-1006L  // memory allocation failed


-1007L  // the requested line is not available


-1008L // invalid window parameter in OpenLine


-1009L // invalid window parameter in OpenLine


-1019L  // task was aborted with AbortTask


-1020L	// AT+FET error


-1021L  // +FHNG after data - error receiving


-1022L // fax calling tone detected


-1023L  // modem carrier detected


-1024L //handshake failed


-1025L // maximum silence


-1026L  // handset/line hangup


-1027L //readfile failed


-1028L //writefile failed


-1029L //send error - try again.


-1030L  // uWaitDigits or uMaxDuration timed out


-1032L  // error writing command to modem


-1033L  // ERROR response from modem


-1034L  // no response from modem


-1035L	// Data underflow in voice mode


-1036L	// No carrier. Happens during receivefax when remote caller is voice


Call accounting


Call costing can easily be done using Excel or Access. FAXmaker logs all incoming and outgoing faxes in the two files; Sendlog.txt and rcvlog.txt. The files are located in the main faxmaker directory. Using the information in those files, a detailed report can be made.


Send log file


The following information is stored for each outgoing fax;


Date,Time,SenderEmail,SenderName,BillinCode,RemoteId,RecipientName,RecipientCompany,RecipientNumber,CallDuration,PagesTransferred,Result,Info,Port,FilesInArchiveDir


For example;


"22/12/96","22:18:16","nick@gfitest","nick","","88888888","nick","gfi","nick_gfi_23 <fax@gfitest>","00:30","1","SUCCESS","Fax has been sent successfully","COM2",""


Receive log file


The following information is stored for each incoming fax;


Date,Time,RemoteID,CallDuration,PagesReceived,Result,Info,Port,FileInArchiveDir,RoutedTo.


For example;


"21/12/96","20:14:03","88888888","00:39","1","SUCCESS","Fax received","COM2","","nick@gfitest,alexm@gfitest,bart@gfitest"


Internet site http://www.gfifax.com  


More information regarding technical support and tips for using FAXmaker can be found on our web site;


http://www.gfifax.com.


The web site will always have the most up to date listing of tips and support questions.





�
CoverPages & Templates


Introduction


Coverpages and templates (similar to cover pages but used for outgoing emails), can be used by all FAXmaker users. You can design your cover page� XE "cover page" \r "D2HBcover_page29" � or template to include your company logo, sender and recipient fields, message fields and any bitmap images. You could also use or customise the existing templates included in FAXmaker.


Designing a coverpage/template


FAXmaker uses a standard rich text format file as a template to create cover pages. 


The rich text format (RTF) is a standard amongst word processors and is supported by virtually any word processor, including MS Word, Amipro and Wordpad (included in Windows 95). This means that you can create your template in your favourite word processor, and just include the merge fields such as the recipient name, company and message text by inserting a field where you wish to have the actual names/information inserted. For example, to have a field recipient name filled in, include a text <R_Display> in the coverpage template.


For example a very simple coverpage with recipient name and company could be created as follows;


Recipient Name: <R_Display>


Company: <R_Company>


Supposing you want to send a fax to Pete Johnson at York computers, the fax would be sent out as follows;


Recipient Name: Pete Johnson


Company: York computers.


The merge fields in the RTF file are replaced by the  recipient information and then the coverpage is converted to fax format.


The easiest way to design a cover page is to adjust one of the samples included with FAXmaker in the coverpage directory. To do this simply open up one of the coverpages in your word processor, for example Wordpad, and move around, add or delete merge-fields and/or text as you wish. 


After you have finished designing your cover page, save the template as an RTF file and assign it to a user.  If you wish to make a default coverpage for the entire company, modify the file template.rtf in the the Faxmaker\coverpge directory.


Coverpages and templates can also be created and installed by the users themselves. For more information see the chapter on ‘Remote administration.


TIP; Use Wordpad or MS Word to design your coverpages/templates. FAXmaker uses conversion technology used by these applications also, and therefore it will give you “what you see is what you get”


�


The rtfcvt32 utility lets you quickly convert your coverpage/template and preview the result of your artistic efforts.


TIP; use the rtfcvt32.exe program located in the FAXmaker directory to preview� XE "Preview" � your template/coverpage as a fax file. 


Supported merge-fields;


The following merge-fields may be used in the RTF file.


Sender fields; 


These fields are replaced by the sender information.





Address Fields�
Merge code�
�
Initials�
<S_Initials>�
�
Last�
<S_Last>�
�
Company�
<S_Company>�
�
Display	�
<S_Display>	�
�
Department�
<S_Department>�
�
Office�
<S_Office>�
�
Phone�
<S_Phone>�
�
Fax�
<S_PH_Fax>�
�
Recipient fields


These fields are replaced by the recipient information.





Address Fields�
Merge code�
�
Initials�
<R_Initials>�
�
Last�
<R_Last>�
�
Company�
<R_Company>�
�
Name	�
<R_Display>�
�
Fax�
<R_PH_Fax>�
�
General fields


Message text:		<message>


This field inserts the text of the coverpage as entered in the Email message. Be sure to leave enough space in the RTF file.


Current time:		<time>


Current date:		<date>


These fields insert the date and time of the fax. Please note that the date and time of the server machine will be used.


Subject:		<subject>


This field inserts the subject line of the message


Tips on designing a cover page


When designing your cover page in RTF format, please take note of the following;


a. To preview your cover page as a fax, use the rtf2fax program located in the FAXmaker directory


b. Remember that RTF does not support tables and headers/footers


c. Remember that merge fields are replace by the actual field values. Therefore, if you do not leave sufficient space, long names can mix up your formatting.


�
Sending Faxes with FAXmaker


Benefits of sending faxes with FAXmaker


�
FAXmaker allows you to send and receive faxes from your PC, without having to print the document first, walk to the fax machine, key in the fax number and reschedule at a later stage if the number is busy.


Instead, FAXmaker uses a FAX server computer, located on your network, which is assigned all Fax related jobs, and also allows you to send and receive faxes at the same time!�
�
The benefits


You no longer need to print out a document prior to faxing it.


FAXmaker will automatically retry fax numbers if they are busy.


Your faxes are more legible and of a better quality, since they are sent directly from your PC, using high resolution techniques.


Incoming faxes can be automatically routed to you as soon as they are received.


Only you can view your outgoing and incoming faxes.


You can easily send faxes to groups� XE "Groups" � of people. 


Ways to send a fax


There are several ways to send a fax with FAXmaker:


1.  Create or open a document in any Windows application and print it with the FAXmaker printer driver. This automatically activates your Email application (Depending on which Email application you use and which standards it supports) from which you can send the fax.


OR;


2.  Start your Email package to send any text you can type in the Email package.


Sending a Fax from an Application


Sending a fax from a Windows application is a simple process in which you make a document in your word processor or any Windows application, and then fax it using FAXmaker's printer driver. If you can print the document in Windows, you will be able to fax it with FAXmaker. Follow the steps outlined in this section to fax your registration form to GFI FAX & VOICE:


1.  Start Write/Wordpad.


2.  Enter some text or open and existing document.


3.  Choose the FAXmaker printer driver as your current printer. The FAXmaker printer driver is a mechanism which stores your document as a fax file. 


a.  From Write's 'File' menu, choose 'Printer Setup'. Select the FAXmaker printer driver and choose 'OK'.


�


Selected FAXmaker printer driver


4.   Print your letter.


a.  From Wordpad/Write's 'File' menu, choose 'Print'. In the 'Print' dialog box, click on 'OK'. 


b.  Immediately after the printer driver has printed your document, the Email package starts.


5.  Click on the 'To' field in your send message dialog.


�


Eudora send message dialog with FAXmaker attachment


6.  Enter 011,356661072 <fax@domain.com> (The last part depends on which name you used for the fax server mailbox) If you wish to store this fax number for future use, give it a ‘Nickname’. In Eudora this is achieved using the Make Nickname function, or by pressing the Ctrl+K key combination.


�


Creating a Nickname


7.  You can attach files to your message using the attach file function.


Note; When attaching files other than FAXmaker fax files, make sure that all fonts and objects that you included in your document are available to the server also.


8.  Click on the 'Send' button, when you are ready. The fax will be sent by FAXmaker, and it will notify you on the status of the fax.


Specifying additional recipients for the fax


One can specify multiple recipients using your Email package, but a list of additional recipients can also be added using an extra options line in the body of the message. 


To add an additional recipient, simply type a double colon followed by name (optional), company (optional) and number. For example;


::Registration, GFI FAX & VOICE, 00,356661072


One can add a whole series of recipients in this manner.


� XE "FAX options" \r "D2HBFAX_options36" �FAX Options


When sending a fax you can enter send options such as high or normal resolution, schedule time, cover page� XE "cover page" \r "D2HBcover_page36" � to be used etc., at the top of the mail, preceded by a double colon.


You only need to specify fax options in this way, if the defaults which you or your administrator� XE "administrator" � have set, need to be overridden. For more information on this, see remote administration.� XE "Remote administration" �


The following options can be used;


To specify a cover page


C=<cover page name>, e.g ::C=cover1


Where <cover page name> stands for the name of your cover page. If you do not want to send a coverpage, but by default a coverpage is added, you can override this option temporarily by specifying “none” instead of a cover page name. This will cause FAXmaker not to add a coverpage. Remember that the cover page must be stored on the server first.


To specify high or low resolution


'H' or 'N', e.g. ::H


Where H stands for high resolution (200 * 200 dpi) and N for normal resolution (200 * 100 dpi).


To specify a template


T=<template name>, e.g. ::T=template2


Where <template name> stands for the name of the template. Remember that the template must be stored on the server first.


To schedule a fax


nn::mm, e.g. ::23:15 


Where nn equals hours and mm equals minutes


To specify a billing code� XE "Billing code" �


Bnnnn, e.g ::B5


Where nnn can be replaced by any number. This number will be added in the log file and can then be used to apportion costs.


To attach a file to your fax


A=<name>, e.g. A=brochure


Where <name> stands for the name of a fax attachment.� XE "Fax Attachment" \r "D2HBFax_Attachme36" � Remember that the fax must be stored previously on the server. Multiple attachments� XE "attachments" \r "D2HBattachments36" � can be added to the fax.


Skip Queue


S, e.g. ::S


S stands for Skip Queue. This option is handy when you have submitted a large fax mailing and you wish to send out this fax immediately.


Multiple options


When you are using multiple options in a message, you must put them on the same line, separated by a comma.


For example;


:: c = cover , t=templ, a=attach, h, 23:01


This example sends a fax with “cover” as a cover page, formatted in “templ” with the attachment “attach”. Furthermore, the fax is sent in high resolution and scheduled to be sent at 23.01 hours.


Note; Remember that prior to using fax options, you must ensure that you have actually stored the attachments, templates and coverpages that you are using.


Creating a Fax Attachment


Attachments can be handy to store frequently faxed information such as product brochures. These can be graphics intensive, so it makes sense to convert them only once to fax format and store them as fax attachments. To create a fax attachment;


1.  Start the application in which the document is saved.


a.  From that application's menu, choose 'Print Setup'


b.  Select the FAXmaker printer driver and click OK. The Email package will pop up.� XE "Pop up" �


c. Double-click on the attachment. The viewer will convert and load the fax.


d. To save the fax as an attachment, simply use the save as function in the viewer.


e. You can either choose to send this attachment immediately, or cancel the send fax process and return to the application.


TIP: Use the remote administration feature to create an attachment;


1. Print your document to the FAXmaker printer driver


2. Specify FAXadmin as the recipient.


3. In the subject of the mail message specify the name of the attachment using the following command;


A=<Attachment name>, e.g A=brochure


4. Send the message. You will receive a notification that your fax has been stored. The notification will include the ready converted fax file!


Receiving a Fax


Incoming faxes are logged in your mailbox.� XE "Mailbox" � The message will ready “FAX from”, followed by the FAX ID� XE "Fax ID" � (CSID� XE "CSID" �). To view the fax, double-click on the message, and then double-click on the attachment. The FAXmaker viewer will load and display your fax.


�


Eudora with a received fax message. The mail message show the fax report, and the inbox shows the sender’s fax ID





�
� XE "Remote administration" �Remote administration


Introduction


Each user has a set of options or defaults which specify how a fax must be sent by FAXmaker. These options include which coverpage to use, template, fax attachments� XE "attachments" \r "D2HBattachments39" � if any, and even the resolution at which the fax must be sent.


These options can be set from the User configuration utility.� XE "Exchange administrator" �� XE "administrator" � However, in order to reduce the administration burden, these options can also be set by the user themselves. This is can be done by sending message to the faxadmin, and is called “Remote administration”


FAX admin


Remote administration is done by sending messages to the ‘Fax administrator’. Sending a message to the the Fax administrator is exactly the same as sending a fax, however instead a fax number, you enter faxadmin. For example:


faxadmin <fax@domain.com>


It is convenient to create a nick name for the faxadministrator called faxadmin.


This way the FAXmaker server will know that this message concerns an administration option.


�


Addressing to the FAXmaker administrator


Coverpage administration options


FAXmaker allows users to add multiple coverpages which can be used interchangeably, and to set a particular coverpage as default.


Before a coverpage can be used, the coverpage file (RTF format) must be stored on the server and it must be given a name.


To store a coverpage:


Send To:	FAXADMIN


Subject:	C=<coverpage name>{ ,default }{ ,delete }


Insert coverpage as attachment


Do not add multiple attachments. To insert an attachment in your email package, use the Attach file command from the message menu.


If you wish this cover page� XE "cover page" � to be the default coverpage, add “, default” in the subject line.


If you wish to delete this coverpage file and name, add “, delete” in the subject line and do not attach a file.


Template administration options


FAXmaker allows users to add multiple templates which can be used interchangeably, and to set a particular template as default.


Before a template can be used, the template file (RTF format) must be stored on the server and it must be given a name.


To store a template:


Send To:	FAXADMIN


Subject:	T=<template name>{ ,default }{ ,delete }


Insert template as attachment


Do not add multiple attachments. To insert an attachment in your email package, use the Attach file command from the message menu.


If you wish this template to be the default template, add “, default” in the subject line.


If you wish to delete this template file and name, add “, delete” in the subject line and do not attach a file.


Attachment administration options


FAXmaker allows users to store attachments, for example a price list or product brochure. This has the advantage, that you do not need to resent the physical file each time you want to attach it to your fax.


Before an attachment can be used, the attachment ( in FAXmaker fax format) must be stored on the server and it must be given a name.


To store a fax attachment:� XE "Fax Attachment" �


Send To:	FAXADMIN


Subject:	A=<attachment name>{ ,delete }


Insert attachment as attachment


Do not add multiple attachments. To insert an attachment in your email package, use the Attach file command from the message menu.


If you wish to delete this attachment file and name, add “, delete” in the subject line and do not attach a file.


Setting the default fax resolution


Each user can specify the default resolution with which a fax must be sent. A fax can be sent at high resolution, which results in a sharper looking fax but also in longer transmission times, or in normal resolution, which cuts transmission time roughly in half.


To change the default resolution setting;


TO:		FAXADMIN


Subject:	defaults


In the Message-body:


Resolution = High or Normal





� XE "FAX header" \r "D2HBFAX_header41" �Setting the FAX header


Each user can specify a personal fax header, to be displayed on top of each fax he/she sends. 


To enter a personal fax header;


Send To:	FAXADMIN


Subject:	defaults


In the Message-body:


FAX header = <Faxheader>


Where fax header is the word or number to appear on top of the fax.


Setting multiple options at a time


You can specify multiple default  settings at one go, by adding several command lines. For example;


Send To:	FAXADMIN


Subject:	defaults


In the Message-body:


Coverpage = testcoverpage


Template = testtemplate


FAX header = GFI


Resolution = high


This will set testcoverpage as the default coverpage, testtemplate as the default template, GFI as the personal fax header and high as the default fax resolution.


Retrieving the defaults


To retrieve your personal default settings at any one time, simply send a message to faxadmin with defaults as the subject of the message.


To retrieve the defaults;


Send To:	FAXADMIN


Subject:	defaults


Leave the Message-body empty





�
The Viewer


Introduction


With the FAXmaker Viewer, you can view, print and save fax files. The FAXmaker Viewer can be activated by double-clicking on a FAXmaker attachment in a message dialog. 


�


The FAXmaker viewer (Windows NT 4/95 only, other platforms do not  include annotation.)


Viewing Faxes


The viewer is used to:


1.  View incoming or outgoing faxes,  by double-clicking on the fax attachment� XE "Fax Attachment" � in the Message dialog of your Email package. The FAXmaker Viewer is automatically activated and displays the fax on screen.


2.  To preview� XE "Preview" � outgoing faxes, by double-clicking on the fax attachment in the Message dialog of your Email package. The FAXmaker Viewer is automatically activated and displays the fax as it will be sent.


In the Viewer itself you can:


a.  Preview pages one by one, using the 'Next' or 'Previous' command from the 'Page' menu. When your document is made up of one page, these functions will be dimmed.


b.  Re-size the document on your screen by choosing either the 'Horizontal Fit' or the 'Vertical Fit' from the 'View' menu.


c.  Zoom in or out whilst viewing the document from a number of viewpoints by choosing an appropriate zoom value from the 'View' menu. 


d.  Invert the image by choosing the Invert command from the 'View' menu.


e.  Print the document to your local printer by choosing the 'Print' command from the 'File' menu.


f . Save the fax on your hard disk. Choose the 'Save as' function from the 'File' menu (or click on the 'Save as' icon) and type the file name in the 'Save as' dialog. You can save documents in '*.fax', '*.tiff' or '*.dcx' file format. Choose 'Exit' from the 'File' menu.


Scale to Grey


The advanced fax viewer, available for Windows 95 and NT 4, includes a scale to grey option (located in the view menu), which allows you to view the fax at a much higher resolution. 


Fax annotation


In Windows 95 or NT 4, you can annotate faxes using the advanced FAXmaker viewer. The following annotation tools are at your disposal


�


Annotation tools


1. Select annotation.


2. Draw freehand line.


3. Highlight a particular section of a fax.


4. Draw a straight line.


5. Draw a rectangle.


6. Draw filled rectangel


7. Add text to a fax


8. Attach a note.


9. Add text stored in a file.


10. Add a stamp


To change any of the defaults the tools, right click your mouse above a tool and select properties. For example, the default stamp texts can be changed in this way.


Save your annotations! Your annotations are only made permanent if you select save from the menu.


�
Troubleshooting


Server software problems


“The modem does not dial out.”


In some cases your modem may not dial out, returning the error message “No dial tone”. The problem could be caused by the fact that not all export� XE "Export" � modems recognise the dial tone. To solve this, disable “Wait for Dial Tone” in the Fax setup window of the server.


FAQ on http://www.gfifax.com  


An FAQ is a list of frequently asked questions (FAQ). GFI FAX & VOICE maintain a support FAQ, which lists answers to most common problems. If you have a problem with FAXmaker and access to the INTERNET, please access this FAQ first. 


The website URL is http://www.gfifax.com/pages/intrafaq.htm. The FAQ is located under the section product support.


The web site will always have the most up to date listing of support questions and patches.�
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